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Introduction
This chapter explains basic and necessary knowledge before using "ImageMixer 
3 SE". Please read this chapter before operation. Also, please refer to the instruc-
tion manual of your camcorder.



Chapter 1  Introduction

�

About The Software Guide
This guide explains how to use "ImageMixer 3 SE Ver.3" (referred to as "ImageMixer 
3") and  "ImageMixer 3 SE Player Ver.3" (referred to as "ImageMixer 3 SE Player").

This guide does not mention basic operations of Windows Operating System.
Menu selection and window operations are based on general operation proce-
dures of Windows Operating System. 

It is prohibited to reproduce the content of this guide, fully or partially, without 
notice. 

The content of this guide may be modified without notice. 

Please contact our User Support Center if you have any questions. 

Illustrations in this guide show screen captures of the software under develop-
ment. They may be different from the actual software. 

Symbols Used in This Guide
This guide uses the following symbols.

	This symbol indicates a reference page relating to the topics.

	 This symbol indicates important notice for operations.

	 This symbol indicates a useful hint for operations.

•

•

•
•
•
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Trademarks
ImageMixerTM is a trademark of PIXELA CORPORATION.

Windows(R) is a registered trademark of Microsoft Corporation in the U.S.A. 
and other countries.

The official name of Windows is Microsoft(R) Windows(R).

Manufactured under license from Dolby Laboratories."Dolby" and the dou-
ble-D symbol are trademarks of Dolby Laboratories. Confidential unpub-
lished works. Copyright 1992–1997 Dolby Laboratories. All rights reserved.

iPod, iTunes are the trademarks of Apple Inc.

"AVCHD" and "AVCHD" logo are trademarks of Matsushita Electric Industrial 
Co., Ltd. and Sony Corporation.

Blu-rayTM is a trademark of the Blu-ray Disc Association.

The company names and brand names referred to in this guide are them-
selves the trademarks, registered trademarks, and products of their respec-
tive companies.

The (R) and TM marks have been omitted in this instruction manual.

•
•

•
•

•
•

•
•

•
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Before Using ImageMixer 3
The system configuration described below is required in order to use this software.

This does not guarantee full operation.

Better system configurations may be necessary depending on the number of videos and 
total data volume of the content to be authored.

System Requirements

Supported OS/Computer

Microsoft Windows XP Service Pack 2
Microsoft Windows XP Service Pack 3

 Home Edition

 Professional

Microsoft Windows Vista
Microsoft Windows Vista Service Pack 1

Home Basic

Home Premium

Ultimate

Business

Enterprise

English versions of above operating systems
Only 32-bit versions of the operating systems are supported.

To install and use this software, you must be authorized as an Administrator.

Updating to Windows XP Service Pack 2 or 3 is required for Microsoft Windows XP users.

Supported Computer

IBM PC/AT compatible computers (DOS/V) with above OS pre-installed.
Built-to-order computers excepted.

※

※

♦
♦

•
•

♦
♦

•
•
•
•
•

※

※

※

♦

※
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System configuration for full use of functions (including 
playing back and editing videos in AVCHD standard)

CPU

Microsoft Windows XP / Microsoft Windows Vista
Intel Pentium D / 3.0 GHz or higher,  Intel Core 2 Duo / 2.13 GHz or higher

MXP mode (recoding mode):  Intel Core 2 Duo / 2.33GHz or higher

Operation is not guaranteed when using over-clocked CPUs.

Memory

Microsoft Windows XP: 1 GB or higher

Microsoft Windows Vista: 2 GB or higher

Hard Disk

300 MB or more free disk space is required for software installation.

Free space at least twice the volume of data to be written on the disc is re-
quired for creating a disc.

Graphics

1280x1024 pixels or more, 32 bit or more, Intel G965 (onboard VGA) or higher

Sound

Sound card supporting DirectSound 

Drive

Built-in disc drive with DVD writing capabilities

Disc drive with Blu-ray writing capabilities

Others

Standard USB 2.0 port

An environment in which DirectX 9.0c operates properly

An Internet-accessible environment for software installation

⒈

♦

•

※

♦

♦

•
•

♦

•
♦

•
♦

•
•

♦

•
•
•
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System configuration for creating discs (AVCHD), saving 
on computer, and writing back to the camcorder

When creating a disc in AVCHD standard, whose videos were recorded in MXP mode 
(recoding mode), a system configuration mentioned in P12 is required.

CPU
Microsoft Windows XP

Intel Pentium 4 / 1.49 GHz or higher

Intel Celeron / 1.7 GHz or higher

Microsoft Windows Vista
Intel Pentium 4 / 2.4 GHz or higher

Intel Celeron D / 3.0 GHz or higher

Operation is not guaranteed when using over-clocked CPUs.

Memory
Microsoft Windows XP: 512 MB or higher

Microsoft Windows Vista: 512 MB or higher

Hard Disk
300 MB or more free disk space is required for software installation.

Free space at least twice the volume of data to be written on the disc is re-
quired for creating a disc.

Graphics
1024x768 pixels or more, 16bit (Hi-color) or more

Sound
Sound card supporting DirectSound 

Drive
Built-in disc drive with DVD writing capabilities

Others
Standard USB 2.0 port

An environment in which DirectX 9.0c operates properly

An Internet-accessible environment for software installation

⒉

※

♦

•

•

※

♦

♦

•
•

♦

•
♦

•
♦

•
♦

•
•
•
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Cautions
If recorded and/or edited content includes copyrighted works created by 
third parties, be sure to use them for personal use. 

Use an AC adapter to power a notebook computer.

Use the compact power adapter to power the camcorder.

Connect the camcorder and the computer directly with a USB cable. Opera-
tion using USB hubs is not guaranteed.

Do not put the computer in Standby mode when a camcorder is connected.

Read-protected data and copy-protected data cannot be imported.

You cannot overwrite recorded DVD-R, DVD-R DL, BD-R, and BD-R DL discs. 
When using a rewritable disc, erase the recorded data with "ImageMixer 3" 
before writing.

Do not operate other software during disc writing.

You cannot write back videos to the SD Memory Card inside the camcorder 
if the card is protected against writing.

Usable Videos with ImageMixer 3
The following video files and discs can be used with “ImageMixer 3”:

Videos recorded with a Canon camcorder with which "ImageMixer 3" is 
bundled.

Discs created from said files (1), that were edited and/or authored using 
"ImageMixer 3".

Still image files cannot be used with "ImageMixer 3 SE".

Audio files cannot be used with "ImageMixer 3 SE", except for audio importing in the Movie Edit 
screen..

•
•
•
•
•
•
•

•
•

⒈

⒉
※

※
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Operating Limitations
Unicode is not supported in "ImageMixer 3".

Even if video recordings are in a supported format, you may not be able to 
use them depending on the recording method.

You cannot use "ImageMixer 3" when connecting two or more camcorders 
to the computer.

You cannot use "ImageMixer 3 SE Player" and "ImageMixer 3" at the same time.

When playing back a disc using "ImageMixer 3 SE Player", playback will not 
seem smooth during fast playback (forward or backwards). 

System folders, Windows-only folders, the root directory C:\ and optical drives 
cannot be selected as the saving destination for the Library or for exporting 
files.

For details about the Library, refer to P48.

You cannot add files to the Library by dragging and dropping files from re-
movable disks in Windows Explorer.

For details about the Library, refer to P48.

After exporting files with "ImageMixer 3", the picture quality of the exported 
video will be lower than that of the original.

In the Movie Edit screen, you can set up to 20 trimming ranges for a clip.

Video preview in the Movie Edit screen may not be played back smoothly 
depending on your computer's configuration.

In the Movie Edit, the titler displayed on the preview screen may be distort-
ed depending on the computer. This is not reflected in the edited content.

Discs created with “ImageMixer 3” may not be played back on some players. 

When playing back titles, the joining points between chapters may not be 
played back smoothly. In Movie Edit, place clips on the Working area in a 
row, export them as one video file, then save the file on a disc. Playback 
will now be smooth. Note that the exported file created in the Movie Edit is 
a different file. It is recommended not to delete the files used for exporting 
and keep the files as they are.

Disc writing cannot be performed if the Windows file system is FAT32.

"ImageMixer 3" may not operate correctly when a disc writing software oth-
er than "ImageMixer 3" is installed. In this case, we recommend not to use 
multiple disc writing software at the same time.

•
•
•
•
•
•

※

•
※

•
•
•
•
•
•

•
•
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When erasing data on a rewritable disc, the progress bar may not be dis-
played correctly for some drives.

You cannot write back to the camcorder videos that were recorded in a 
video format or video system different from that of the camcorder. It may 
cause the camcorder to malfunction.

When importing the file written back from "ImageMixer 3" to the camcorder, 
the file size may be different from the file which was imported first, however 
there is no difference in the picture quality and other elements. 

Refer to the following Web site for the latest information about operating 
limitations.

http://www.pixela.co.jp/oem/canon/e/

•
•

•

•
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Supported Files

Importing

Recording standard

AVCHD standard

BD-R 2.0 standard

BD-RE 3.0 standard

File format (extension)

H.264/AVCHD (.mts, .m2ts)

WAVE (.wav)

MPEG-1 Audio Layer-3 (.mp3)

Disc type

DVD-R 

DVD-R DL

DVD-RW

BD-R

BD-R DL

BD-RE

BD-RE DL

Writing on 8 cm disc is not supported.

♦

•
•
•

♦

•
•
•

♦

•
•
•
•
•
•
•

※
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Writing

Recording standard

DVD-Video standard

AVCHD standard

BD-R 2.0 standard

BD-RE 3.0 standard

File format (extension)

Movie Editing: H.264 (.m2ts)

Still image: JPEG (.jpg)

File export (for computer / for video-sharing site): MPEG-2 (.mpg)

File export (for iTunes): MOV (.mov)

Disc type

DVD-R 

DVD-R DL 

DVD-RW 

BD-R

BD-R DL

BD-RE

BD-RE DL

Writing on 8 cm disc is not supported.

You cannot add recordings on rewritable discs that have already been recorded.

When using a rewritable disc, erase the recorded data with "ImageMixer 3" before writing.

♦

•
•
•
•

♦

•
•
•
•

♦

•
•
•
•
•
•
•

※

※

※



Preparation
This chapter explains the preparations before starting "ImageMixer 3".
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Installation/Uninstallation

Installation

Verify the Internet connection.

During the installation procedure, certification of the software is performed through 
the Internet. Users with an Internet connection: please have your computer connected 
to the Internet before the installation.

When Internet connection is unavailable

Contact a User Support Center (P159) and acquire your certification code.

Insert the software CD-ROM into your computer.

The installation screen will be displayed.

In Windows Vista, the [User Account Control] dialog box will be displayed. Click [Con-
tinue].

Select your language and click [Next].

⒈

あ

⒉
➡

※

⒊
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Click [Next].

Confirm the License Agreement.

Click [I accept the terms of the license agreement].

Please confirm the content of the License Agreement before clicking.

Click [Next].

⒋

⒌
①

※

②
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Select the installation folder.

By default, the program is saved in "C:\Program Files\PIXELA\ImageMixer 3 SE Ver.3". 
If you do not need to change the destination, click [Next] to go to step 7.

If you want to change the destination, follow the procedure below.

Click [Change...].

Select the installation folder and click [OK].

Select your local video system and click [Next].

After installation, you can change the video system in the "Preferences" screen. (P58)

⒍

①

②

⒎
※
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Enter your camcorder's serial number and click [Next].

The serial number you enter will be sent through the Internet. If the number is correct, 
the certification  code is registered and certification of "ImageMixer 3" (the product acti-
vation) is completed. You can continue the installation after this procedure.

For the location of the serial number, refer to the instruction manual of your camcorder.
Personal information will not be collected as the part of the product activation.

When the dialog box to input certification code is displayed

If your computer is not connected to the Internet, the certification dialog box will be 
displayed. Connect your computer to the Internet. If you do not have an Internet con-
nection, call our User Support Center and acquire the certification code, then enter it 
and click [Next].

Click [Install].

Installation will start.

⒏
➡

※
※

あ

⒐
➡
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Click [Finish].

Check "Yes, I want to restart my computer now." and click [Finish].

Your computer will be restarted.➡
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Uninstallation
Make sure to exit "ImageMixer 3" and "ImageMixer 3 SE Player" before uninstallation.

Windows XP

Click the [start] menu.

Click [Control Panel].

Click [Add or Remove Programs].

⒈

⒉

⒊
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Select [ImageMixer 3 SE Ver.3] and click [Remove].

Click [OK].

Uninstallation will start.

⒋

⒌
➡
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Windows Vista

Click the [Start] menu.

Click [Control Panel].

Click [Uninstall a program].

⒈

⒉

⒊
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Select [ImageMixer 3 SE Ver.3] and click [Uninstall].

The [User Account Control] dialog box will be displayed.

Click [Continue].

A confirmation dialog box will be displayed.

Click [OK].

Uninstallation will start.

⒋
➡

⒌
➡

⒍
➡
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Starting and Exiting

Starting
You can start "ImageMixer 3" in any of the following ways:

Connect the camcorder.
"ImageMixer 3" starts automatically when the camcorder is connected.

Start from the shortcut icon.
Double-click the shortcut icon on the Desktop.    ImageMixer 

3 SE Ver.3

Start from the [Start] menu.
Select the [Start] menu-[All Programs]-[PIXELA]-[ImageMixer 3 SE Ver.3]-[ImageMixer 3 
SE Ver.3].

"ImageMixer 3 Launcher" screen will be displayed.

For details about "ImageMixer 3 Launcher" screen, refer to P34.

Exiting
Click [ ] / [ ] on the upper right screen. 

Close all dialog boxes and setting screens before exiting.

•

•

•

➡

て

※

Windows VistaWindows XP Windows VistaWindows XP
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Connecting/Disconnecting the Camcorder
If the camcorder is disconnected from the computer while using "ImageMixer 3", 
video files in the camcorder may be damaged. Follow the instructions below when 
disconnecting the camcorder from the computer.

Use the compact power adapter to power the camcorder.

Connect the camcorder and the computer with a USB cable. Operation using a 
USB hub is not guaranteed.

When disconnecting the USB cable, click the "Safely remove USB Mass Stor-

age Device "icon ( (XP)/ (Vista)) to release camcorder connection.

Connecting the Camcorder
Connect the camcorder to a wall outlet using the compact power adapter.

Turn on the camcorder and set it to the movie playback mode.

Connect the camcorder and the computer with a USB cable.

The selection dialog will appear on the camcorder's LCD panel.

Select the connection to the computer using camcorder's joystick.

The "ImageMixer 3 Launcher" screen appears on the computer.

Disconnecting the Camcorder
Click [ ](XP) / [ ](Vista) on the lower right screen.

Click [Safely remove Mass Storage Device -Drive(X:)].

The letter that appears as "Drive (X:)" varies depending on the computer.

If multiple choices are displayed, select the drive corresponding to the camcorder.

A message informing you it is safe to remove hardware will be displayed.

Disconnect the camcorder.

•
•
•

⒈

⒉

⒊
➡

⒋
➡

⒈

⒉
※

※

➡

⒊



Startup
This chapter explains the overview of "ImageMixer 3" functions and initial opera-
tions after starting "ImageMixer 3".
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What You Can Do with ImageMixer 3

Playing Back Videos
Plays back videos in the camcorder

You can play back the videos stored in the camcorder by connecting  your camcorder 
and the computer.

Plays back videos in the computer
You can play back video files in the computer.

Importing and Organizing Videos (Library)
Saves videos to the computer

Videos in the camcorder can be saved to the computer.

Organizes videos
In the Library screen of "ImageMixer 3", you can organize videos by date or file format, or 
you can arrange the playback order.

•

•

•

•
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Editing Videos
Adds effects to videos

You can add text to the scenes or add transition effects between the scenes. Also, you 
can change the volume of the video, or add narration and music.

Saves multiple video files as one file
You can trim unnecessary scenes and combine multiple video files into one file.

Storing Videos
Creates discs of videos that were recorded with the camcorder

You can write the videos in the camcorder directly to a disc, or select which videos to 
write on a disc with a DVD or BD menu screen.

For usable discs and players, refer to P125.

Writes back to the camcorder
You can change the playback order and write back videos to the camcorder.

You can write back videos originally saved on the computer from the camcorder with which 
"ImageMixer 3" is bundled, and videos that were edited with "ImageMixer 3".

•

•

•

て

•
※
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Starting ImageMixer 3

ImageMixer 3 Launcher
After starting "ImageMixer 3", the following screen will be displayed. Select 
what you want to do in this screen.

When starting "ImageMixer 3" in Windows Vista for the first time

When starting for the first time and occasionally in other cases, the [User Account 
Control] dialog box may be displayed. Click [Continue] to proceed. 

Create Disc (P126)

Create disc(s) of the videos in the camcorder.

Save Files to PC (P38)

Save videos in the camcorder onto the computer.

あ

₁

₂
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Write Back to Camcorder (P144)

Writes back to the camcorder videos which were imported using "ImageMixer 3".

Browsing & Authoring (P48)

Organize or edit videos. You can also store these videos on a disc.

Exit

Exit "ImageMixer 3".

The [Reading information…] dialog

When you select [Create Disc], [Save Files to PC], or [Browsing & Authoring],　the 
operation screen will be displayed after the file information in the camcorder is read. 
The [Reading information…] dialog is displayed until the file information has been 
read.

It may take time to read when there are many files in the camcorder.

₃

₄

₅

あ

※
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ImageMixer 3 SE Player
Playback software, "ImageMixer 3 SE Player" is also installed when installing 
"ImageMixer 3 SE".

Start up "ImageMixer 3 SE Player" to play back video files.
You cannot use "ImageMixer 3 SE Player" and "ImageMixer 3" at the same time.  Exit "Image-
Mixer 3" if it is running.

For operations, refer to P43.

Starting ImageMixer 3 SE Player

Start from the shortcut icon.

Double-click the shortcut icon on the Desktop.    ImageMixer
3 SE Player
    Ver.3

Start from the [Start] menu.
Select the [Start] menu-[All Programs]-[PIXELA]-[ImageMixer 3 SE Ver.3]-[ImageMixer 3 SE 
Player Ver.3].

※

て

の
•

•



Importing Videos
This chapter explains how to import videos recorded with the camcorder to the 
computer using "ImageMixer 3".
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Importing Videos to the Computer

Importing Videos in the Camcorder to the 
Computer

Turn on the camcorder and set it to the movie playback mode.

Connect the camcorder to the computer.

Refer to P30 for how to connect the camcorder to the computer.

The [ImageMixer 3 Launcher] screen appears on the computer.

When connecting the camcorder

Note the following instructions when connecting the camcorder:

Use the compact power adapter to power the camcorder.

Connect the camcorder and the computer directly with a USB cable. Operation us-
ing USB hubs is not guaranteed.

Do not put the computer in Standby mode when a camcorder is connected.

Click [Save Files to PC] on the [ImageMixer 3 Launcher] screen.

The save destination dialog box will be displayed.  

⒈

⒉
て
➡

あ

•
•

•

⒊
➡
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Select videos to save.

Click [ ] (select videos that have not been saved yet) or [ ] (select all) or se-
lect individual videos you wish to save.

For details about button functions, refer to P41.

Click [Save].

A confirmation dialog box will be displayed.

Save destination

Imported videos will be stored in the [IMxLibrary] folder under the [My Video]/[Video] fold-
er ([My Documents]/[Documents] if [My Video]/[Video] folder does not exist). To change 
the destination, specify the destination in [Preferences...] in the [Settings] menu.

⒋

て

⒌
➡

の
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Click [Execute].

Saving will start. Saved videos are added to the "ImageMixer 3" Library automatically 
and Albums are created by date in the Source pane (P51).

Symbols for the file status

The (Imported mark) is displayed for video files stored in the computer. This mark 
indicates that a video file in the camcorder has already been imported to the comput-
er.

⒍
➡

の
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Screen Displayed when Saving to the Computer

Source pane

The camcorder connected to the computer is displayed.
For details about Source pane, refer to P51.

Browser pane 

A list of the video files in the camcorder selected from the Source pane is displayed.

For details about Browser pane, refer to P53.

Select difference button

Selects videos in the camcorder which have not yet been imported to the computer.

Select all button

Selects all videos on the Browser pane.

Cancel selection button

Cancels all video selections in the Browser pane.

[Save] button

Saves videos in the Browser pane to the computer.
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Playing Back Videos
This chapter explains how to play back videos recorded with the camcorder using 
"ImageMixer 3".
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Playing Back with ImageMixer 3 SE Player

Playing Back
You cannot use "ImageMixer 3 SE Player" and "ImageMixer 3" at the same 
time.  Exit "ImageMixer 3" if it is running.

Playable videos with ImageMixer 3 SE Player

H.264 files

Discs created from the "AVCHD List" in "ImageMixer 3".

Discs created from the "Blu-ray List" in "ImageMixer 3".

Discs created from the "DataDisc List" in "ImageMixer 3".

Start "ImageMixer 3 SE Player".

Double-click the "ImageMixer 3 SE Player" shortcut icon.

You can also start by selecting [Start] menu-[All Programs]-[PIXELA]-[ImageMixer 3 
SE Ver.3]-[ImageMixer 3 SE Player Ver.3].

The player screen will be displayed. 
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Select a video file/disc and start playback.

Click the [File] menu.

Click [Select file] to play back a video file, click [Select disc] to play back a video disc.

Select the file/disc you wish to play.

The selected video will be played back.

When the playback stops briefly at the joining points between chapters 

In Movie Edit, place clips on the Working area in a row, export them as one video file, 
then save the file on a disc. Playback will now be smooth. Note that the exported 
file created in the Movie Edit is a different file. It is recommended not to delete the 
files used for exporting and keep the files as they are.
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Player Screen
The image below is for illustration purposes only. Some items are not displayed at the same 
time.

Navigation button

Controls the menu screen when playing back a disc.

Elapsed time

Shows the current playback position. 

Menu button

Returns to the menu screen when playing back a disc.

Eject button

Ejects the disc being played back.

Playback slider

Shows the current playback position. You can also drag the slider to set where 
to start playing.
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Skip to previous button

Jumps to the previous chapter.

Fast Reverse button

Reverses the video at a higher speed. Everytime you click this button, the speed 
changes x10, x30, x60, and x5.

Playback button

Plays back/pauses video. During playback, the button will appear as Pause but-
ton. 

Stop button

Stops playback.

Fast Forward button

Advances the video at a higher speed. Everytime you click this button, the speed 
changes x10, x30, x60, and x5.

Skip to next button

Jumps to the next chapter.

Mute button

Mutes/restores the volume.

Volume level

Adjusts the volume of the video you are playing.

To change the size of the Player Screen

If you wish to change the size of the Player, select the screen size from the [View] 
menu or drag the edge of the window.

₆

₇

₈

₉

�

�

�

�

の



Importing and Organizing 
Videos (Library)

This chapter explains the Library of "ImageMixer 3", which enables browsing and 
organizing imported videos.
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About the Library

What You Can Do with Library
The way to use "ImageMixer 3" is to add video files saved in the camcorder or 
computer to the "Library". The Library is a place where all the video files used 
in "ImageMixer 3" are stored.

From the Library you can do the following:

Import videos (P59)

Play back videos (P61)

Display detailed information about a video file (P56)

Organize files in the Library (P64)

Create Albums (P65)

Create Smart Albums (P67)

•
•
•
•
•
•
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Create a disc in DVD-Video standard (P131)

Create a disc in AVCHD standard (P131)

Create a disc in Blu-ray standard (P131)

Create a disc for data storage (P131)

Open the Movie Editing screen (P90)

Capture a still image from a video file (P77)

Save a video file in a different format (P79)

Set chapters in a video file (P139)

Library and Albums
The Library is where all the video files used in "ImageMixer 3" are stored. An 
album is used to group videos with a common theme. You can create multiple 
albums and sort the videos in the Library according to your preferences. 

Videos added to an album do not move to the album but remain in the Library. 
Albums are just a convenient way for organizing and displaying videos that 
share a common theme. 

•
•
•
•
•
•
•
•
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About the Library Screens

Basic Screen
The Library screen is composed of three parts. For details, refer to the expla-
nation of the respective parts. 

ImageMixer 3 Launcher button

Returns to the "ImageMixer 3 Launcher" screen.

Source pane

Locations that contain video files.

Browser pane

Displays the list of video files stored in the location you selected in the Source 
pane.
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Source pane

Library

The Library is where all the video files used in "ImageMixer 3" are stored.

Disc drive

Drives connected to the computer. Displays a list of the video files on a disc 
loaded into the drive.

Camcorder

Appears when a camcorder with a built-in memory or hard disk is connected. Dis-
plays a list of video files in the camcorder.

SD Memory Card

Displays a list of video files in the SD Memory Card inserted in the camcorder.
The display changes depending on whether an SD Memory Card is inserted or not.

Removable Disk

Displays a list of video files in an external storage device.
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Album

A list of video files collected from the Library by theme or any categories you 
wish.

Smart Album

A list of video files collected from the Library by specific conditions.

Writing List

A list of video files selected from the Library for creating your original disc. The 
disc type and standard will vary depending on the type of list.

For usable discs and players, refer to P125.

DVD List
The type of Writing List for creating a DVD disc in DVD-Video standard.

AVCHD List
The type of Writing List for creating a DVD disc in AVCHD standard. When creating a disc from 
this List, the maximum bit rate of the video content will be limited to 18 Mbps.

Blu-ray List

The type of Writing List for creating a BD disc. 

DataDisc List

The type of Writing List for creating a DVD disc for data storage. When creating a disc using this 
List, the video content will be saved without changing its quality.

Discs created with the DataDisc List cannot be played back on a standalone DVD player.

What is "bit rate (Mbps)" ?

Bit rate indicates the size of video and audio data transferred per second when 
recording, measured in Mbps. The higher the number, the better the video and audio 
quality.

Add new Album button

Clicking this button creates a new Album.

Utility menu button

Displays available menu options such as adding new Album, adding new Smart 
Album, etc. Menu options vary depending on the item currently selected in the 
Source pane.

Eject button

Displayed when a disc drive is selected. Click to eject the disc in the drive.

₆

₇

₈

て
•

•

•

•

※

の

₉

�

�



Chapter 6  Importing and Organizing Videos (Library)

53

Browser pane

Display Filter

Shows/hides thumbnails or changes the thumbnail size.

Browser pane

Displays the list of video files stored in the location you selected in the Source 
pane. The following details can be displayed for each video file:

File status/Thumbnail/Title/Video format/Audio format/Image size/System bit rate/Aspect ratio/
Playback time/File size/Date recorded/Date added/Date modified/Date edited/My rating/Play count

Symbols for the file status

(Playback)
File being played back.

(Cannot find this file)
The file was added to the Library in the past, but it cannot be found as the file loca-
tion has been changed or the file has been deleted.

 (Cannot drop here)
Appears when dragging a file to where you cannot drop.
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To select View Options for video files

To change View Options, select [Show View Options...] from the [Window] menu, and 
set the options you want to display.

Note that the file status and title cannot be hidden.

To change thumbnail size

Drag the border between [Thumbnail] and [Title] headings in the browser pane to the 
right/left.

[Playback] button

Plays back the selected video file.

[Information] button

Displays the information panel at the bottom of the Browser pane, showing de-
tailed information about the selected video file. You can also add Comments or 
change My rating in the displayed information panel.

[Movie Edit] button

Opens the movie editing screen.

[Disc List] button

Creates a new DVD List, AVCHD List, Blu-ray List, or DataDisc List.
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Screen Displayed when the Camcorder is 
Connected
When you connect the camcorder, the following items are changed from the basic screen.

Browser pane

Information for each video file in the camcorder is displayed.

Symbols for the file status

(Imported mark)
The "Imported mark" is displayed for video files in the camcorder which have already 
been imported to the Library.

[Playback] button

Plays back the selected video file.

[Import] button  

Imports the selected videos to the Library.
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File Information Panel
When you select a video file and click the [Information] button, detailed infor-
mation about the selected file will be displayed. Click [Information] again to 
close the File Information panel.

File Properties tab

The information of [System bitrate] and [Video bitrate] may differ from those of the camcorder.

Options tab

You can change or add My rating and Comments in the Options tab if you like. This will be 
convenient to setup Smart Albums.

Title

You can change the titles of the videos in the Library. The title you set in this 
step will appear on the menu screen of the created disc.

Thumbnail

Displays a thumbnail of the video. You can change the image used as the 
thumbnail by dragging the slider.

Even if you change the thumbnail image, the top scenes of the videos are displayed as thumbnails in the 
menu screen of a created DVD (P138). 
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My rating

You can rank your favorite video files. This rating can be used as one of the rules 
for Smart Albums. Click or drag on the stars to increase/decrease the number of 
stars.

When minimizing My rating

Dragging the star to the left end minimizes the rating.

Comments

You can enter any comments about the video file.
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Preferences Screen
The following screen is displayed when you select [Preferences...] from the 
[Settings] menu. 

The screen below shows the Preferences screen of the Library. Some items are not displayed in 
the Preferences screen for creating discs, saving to computer, and writing back to camcorder.

Workspace

Set a place for the ImageMixer workspace used when editing movies or creating discs. 
The system volume is selected as default. Volumes which you may not write to will not be 
displayed. 

Library destination settings

Set a folder to save the Library contents. The [IMxLibrary] folder in the [My 
Video]/[Video] folder ([My Documents]/[Documents] if [My Video]/[Video] folder 
does not exist) is set as default.

Do not delete the previous Library folder after you change the Library destination. The new Library destina-
tion will only contain files that you are going to add to the Library after the change.

Reset all Imported Marks

Click [Reset] if you want to reset all the Imported marks (P55).

Video System

Select the video system when creating a disc or exporting files in a different format.
When selecting [For computer] in the file export, the video system will be the same as that of the camcorder 

used for recording.
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Adding Videos to the Library

Adding Videos in the Camcorder
To add videos in the camcorder to the Library, refer to P38.

Adding Files in the Computer to the Library
Click [Browsing & Authoring] on the [ImageMixer 3 Launcher] screen.

The Library screen will be displayed.  

Select [Add files to Library...] from the [File] menu.
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Select a file you wish to add and click [Open].

Add using drag & drop

You can also add files/folders to the Library using drag & drop. In Windows Explorer, 
open the folder containing the video file or folder you wish to add and drag & drop 
the files/folders you wish to add to the Library window.

It is not possible to drag & drop from removable disks.

Handling the files added to the Library

"ImageMixer 3" cannot find files if, for example, the files are deleted in Windows Ex-
plorer after being added to the Library. Do not delete or move the video files you use 
in "ImageMixer 3". If you are using removable media such as a USB memory, save 
the video files to the computer in advance, before adding them to the Library.

Handling the files in the camcorder

When you select the files in the camcorder, only the link information will be regis-
tered and the files themselves are not copied to the computer. Files added to the 
Library from the camcorder cannot be used when you disconnect or initialize the 
camcorder. To copy files in the camcorder to the computer, click [Save Files to PC] 
in the “ImageMixer 3 Launcher” screen.

⒊
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Playing Back Videos in the Library
Videos other than those in the camcorder should be imported to the computer before 
playback. To import videos to the Library, refer to P59.

Playing Back
Select a video file to play back.

Click [Playback].

The preview screen is displayed and playback starts.

Playing back videos in the camcorder

Depending on the content, videos in the camcorder may not be played back smoothly 
because of USB transfer rate limitations.
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Preview Screen

Elapsed time

Shows the current playback position. 

Playback slider

Shows the current playback position. You can also drag the slider to set where 
to start playing.

Remaining time / Total time

Displays the remaining time of the video during playback. Clicking this area 
switches the display between total and remaining playback time. 

Skip to previous button

Jumps to the beginning of the video file you are playing back. When the playback 
point is already at the beginning of the video file, it jumps to the beginning of the 
previous video file.

Playback button

Plays back/pauses the video. During playback, the button will appear as Pause but-
ton. 
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Skip to next button

Jumps to the next chapter.

Mute

Mutes/restores the volume.

Volume level

Adjusts the volume of the video you are playing.

To change the size of the Player Screen

If you wish to change the size of the Player, select the screen size from the [View] 
menu or drag the edge of the window.
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Organizing Videos in the Library
When you have a large number of video files in "ImageMixer 3", handling them can 
become difficult. Organizing the files can be made easier by creating Albums by 
theme or any other category you prefer. There are two types of albums you can 
create with ImageMixer:  regular Album and Smart Album.　

Differences between Albums and Smart 
Albums

Album

"Album" is a collection of video files you like, just as a photo album. 

For example, if you create an Album "Birthday party", you can manually select 
and add video files related to the birthday party to that Album. Then, you can 
play back the video files in sequence when you want to watch the birthday party 
videos. 

Smart Album

"Smart Albums" collect video files automatically, taking advantage of electronic 
data. When you set the rules for the Smart Album, video files that match the cri-
teria are collected automatically. 

For example, if you create a Smart Album "April 2008" with the criteria "Videos 
recorded in April 2008", all video files recorded on the specified date are added 
automatically. 
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Creating an Album by Collecting Favorite 
Video Files

Click [ ].

Enter the Album name and click [OK].

A new Album is created in the Source pane.
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Click [Library].

Drag & drop the selected video file(s) to the Album you created in 
step 2.

The selected video file(s) are added to the Album.

To select multiple files

To select contiguous files, hold down the [Shift] key and select files, or to select non-
contiguous files, hold down the [Ctrl] key and select files.

Sorting video files

You can arrange files by clicking the item heading or dragging & dropping files.  
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Organizing Videos Automatically by Set-
ting Criteria (Smart Album Creation)

Select [New Smart Album...] from the [File] menu.

Set the criteria and click [OK].

If you wish to add rule(s), click [ ] on the right and set the rule. If you wish to re-
move rule(s) after setting up multiple rules, click [ ].

Setting up rules in Smart Album

You can set up to 10 rules for one Smart Album.
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Enter the Album name and click [OK].

All the files that match the criteria will be added automatically to the Smart Album.

Sorting video files

In Smart Albums, you can arrange files by clicking the item heading.

Changing the criteria

If you wish to change the rule(s) afterwards, right-click the Smart Album you wish to 
change and select [Edit Smart Album...] from the menu displayed.
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Deleting Files from the Library

Deleting Files from the Library

Click [Library].

Select the file(s) to delete.
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Select [Delete] from the [Edit] menu.

A confirmation dialog box will be displayed.

Select how to delete.

If you wish to delete the file(s) from the computer, select [Recycle Bin]. If you wish to 
remove the display of the file from the Library only, select [Keep files].

Video files which have link information only

When you delete the files which have link information only, and of which original video 
data does not exist in the Library, following dialog box will be displayed. For example, 
deleting a file in the camcorder added from the file selection in the Library.
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Deleting Files from an Album/List

Click the Album/List in the Source pane.

Select the file(s) to delete.
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Select [Delete] from the [Edit] menu.

The video file(s) are deleted from the Album/List.

If you delete file(s) from an Album/List

The file(s) are removed from the Album/List, but they remain in the Library. Files 
cannot be deleted from Smart Albums.
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Deleting Albums/Smart Albums/Lists

Select an Album/List to delete.

Select [Delete] from the [Edit] menu.

If the Album/List contains video files, a confirmation dialog box will be displayed.

If you delete an Album/Smart Album/List

The Album/List will be removed, but the video files in the deleted Album/List will re-
main in the Library.
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Additional Features of the Library

Sorting Video Files

Arranging items in ascending/descending order

You can click an item heading in the Browser pane to arrange the video files in 
ascending/descending order.

Arranging by drag & drop

Select a video file and drag to the location you wish to move the file to.
In Smart Albums, files cannot be sorted by drag & drop.※
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Changing Title Names

Select a video file.

Click [Information].

The File Information panel will be displayed.
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Click the [Options] tab and enter the new name in the [Title] box.

Click [Information] again to close the File Information panel.
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Capturing a Still Image from a Video File

Select a video file.

Select a video file from the Library, Album, Smart Album, or DVD/AVCHD List.

Select [Create still images...] from the [File] menu.

The selected movie will be displayed in the preview screen.
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Display the scene to save.

Display the scene you wish to save as a still image using the slider and frame skip 
buttons.

Click [ ].

The scene is saved as a still image file.

Destination of the captured images 

A captured image is saved as "movie title_Capture.jpg" in the following destination.

Windows XP
C:\Documents and Settings\(User account name)\My Documents\My Pictures\ImageMixer 3 SE

Windows Vista
C:\Users\(User account name)\Pictures\ImageMixer 3 SE
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Saving a Video File in a Different Format
You can export video files added to "ImageMixer 3" Library and convert them 
to a different file format based on your needs.

Why export files in different formats?

By changing the file size, compression method, and resolution, you can create files 
for uploading to a video sharing Web site or files for playing back with an iPod. Ad-
ditional conversion of the exported files by the video sharing site or "iTunes" may be 
required.

Select a video file.

Select a video file from the Library, Album, Smart Album, or DVD/AVCHD List.

Select [Export...] from the [File] menu.
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Change the settings and click [Export].

The exported file is saved in the destination.

Destination to save files

To change the destination, click [Browse...] and select the destination.

Export types

Select file format to save.

For computer
Creates an MPEG-2 file.

iTunes (for iPod)
Creates a file to transfer to an iPod through "iTunes".

For video sharing Web site
Creates a file to upload to a video sharing Web site.

When exporting a file for "iTunes" (for iPod)

"iTunes" is required to convert and transfer the files to an iPod.
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Export format

File information corresponding to [Export types] is displayed.

Default destination

By default, the exported files are saved in the following destination.

Windows XP
C:\Documents and Settings\(User account name)\Video

If the [Video] folder does not exist, the file is saved in the [My Documents] folder.

Windows Vista
C:\Users\(User account name)\Video

If the [Video] folder does not exist, the file is saved in the [Documents] folder.
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Editing Videos
This chapter explains how to edit videos such as combining files and adding vari-
ous effects.
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About the Movie Edit Screens

Basic Screen
The Movie Edit screen is composed of five parts. For details, refer to the ex-
planation of the respective parts. 

Mode bar

Switches between the editing screen and save screen.

Function bar

Import videos to edit and select the type of movie edit.

Settings panel

Displays the setting options selected in the Function bar.

Preview panel

Preview the selected video file.

Working area

Place video files and arrange playback order or set the start and ending points 
of effects.
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Screen Components
Mode bar

[Edit] tab

Displays the movie editing screen.

[Save] tab

Displays the screen to save the edited content (project).

ImageMixer 3 Launcher button

Returns to the Library screen.

Function bar

[Library] button

Displays videos in the Library

[Audio file] button

Displays audio files in your computer.

[Transition] button

 Adds scene transition effects.

[Titler] button

 Adds text on videos.

[Audio] button

 Adds audio to videos.

[Adjust Volume] button

 Adjusts the volume of the clip.
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Settings panel

Panel display differs according to the items selected in the Function bar. For details, refer 
to the explanation of the respective settings.
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Preview panel

Video display

The selected video is played back.

Elapsed time

Shows the current playback position. 

Playback slider 

Drag to change the playback position.

IN-point slider

When trimming video, drag to set the start point of the video you want to keep.

OUT-point slider

When trimming video, drag to set the end point of the video you want to keep.

Playback button

Plays back/pauses video. During playback, the button will appear as Pause button. 
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Stop button

Stops playback.

Skip to previous button

Jumps to the beginning of the selected video file.

Skip to next button

Jumps to the end of the selected video file.

Mute button

Mutes/restores the volume.

Volume level

Adjusts the volume of the video you are playing.
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Working area
The image below shows the Timeline display.

[Storyboard] tab

Displays the order of clips visually.

[Timeline] tab

Displays the order of clips as well as the start/end point of effects such as titler 
and music.

Scaling slider

Changes the time scale of the Timeline display.

Select all button

Select all clips placed in the Working area.

Black screen button

Place a black screen video in the Working area. This clip can be used as a filling 
clip at the beginning and ending of the edited video.

Delete button

Deletes the selected clip.

Capacity bar

 Displays the free space available on the working disk.

Titler

Displays subtitle (text) clips. This line is displayed when selecting the [Timeline] 
tab.
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Video

Displays video clips. This line is displayed when selecting the [Timeline] tab.

Audio

Displays audio clips. This line is displayed when selecting the [Timeline] tab.

Slider

Drag to change the playback position. The scene corresponding to the current 
position of the slider is displayed in the Video display.

Clips

Video, text, and audio placed in the Working area are called "Clips".

How to use Storyboard and Timeline

In the early stage of editing, the Storyboard is useful because you can arrange the 
playback order of the video files visually. In Timeline, video clips are shown as one 
line. It is useful for editing details because the lines of subtitles (text) and audio are 
also displayed.
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Editing

Preparation for Movie Edit
Select the video to edit in the Library and move to the Movie Edit screen.

Click [Library].

Select a file you wish to edit and click [Movie Edit].

A confirmation dialog box will be displayed.
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Click [Edit new movie].

To continue editing a project previously saved, click [Open project and edit movies].

The Movie Edit screen will be displayed.

What's a Project?

Project is a term for movie editing. It refers to the entire operation of movie editing. 
By saving a project, you can stop editing at any point and resume editing later.

Select the resolution and click [OK].

What's Resolution?

Resolution is the screen size of the video edited and exported as one file.
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Refer to following procedures as necessary.

Arranging playback order   P95

Cutting unnecessary scenes (trimming)   P96

Adding scene transition effects (Transition)   P102

Adding text (Titler)   P106

Adding music (background music)   P112

Adding audio to scenes (audio dubbing)   P114

Adjusting the volume (fade-in/fade-out)   P117
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Adding/Deleting clips
“Clips” refers to the video and audio files used for movie editing. To place 
clips in the Movie Edit screen, select video files and select [Movie Edit] in the 
Library screen. Clips are placed in the Movie Edit screen (P90). This section 
explains how to add/delete clips after moving them to the Movie Edit screen.

This operation can be performed both in Timeline and Storyboard view.

Adding clips

Click [Library].

Add the clips to use.

Select a folder in the upper half of the panel and drag & drop a clip from the lower half 
of the panel to the Working area.

You cannot add files from Windows Explorer by drag & drop.
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Deleting clips

Select the clip to delete and click [ ].
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Arranging the Playback Order
You can change the playback order by arranging the video files.

This operation can be performed both in Timeline and Storyboard view.

You cannot scroll through the Working area by dragging a clip.

Drag & drop clips to arrange the order.

Click [ ] to check the result.

To save the edited project as a single video file, refer to P122.
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Cutting Unnecessary Scenes (Trimming)
You can cut unnecessary scenes from the imported video.

This operation can be performed both in Timeline and Storyboard view.

About the edited file

The edited file is saved as an additional file, so the original file remains in the Li-
brary as it is.

Taking out a scene from a video file 

Click the clip you wish to trim.

Adjust the start point of the trimming range with the IN-point slider.
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Adjust the end point of the trimming range with the OUT-point slider.

Check the result of trimming.

Click the [ ] button and check the content.

To save the edited project as a single video file, refer to P122.

Trimming in the Timeline view

In Timeline view, you can also trim videos by dragging the top/end of the clip in the 
Working area. If the clip becomes too short to select, right-click the previous clip 
and select [Select next clip], then adjust using the IN/OUT-point sliders.
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Taking out multiple scenes from a video file 

Right-click the clip to trim and select [Trim multiple ranges].

The multiple trimming screen will be displayed.

Adjust the end point of the trimming range with the OUT-point slider.

Note that the end point setting comes first. 

Adjust the start point of the trimming range with the IN-point slider.
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Click [ ].

Repeat steps 2 to 4 to trim out other scenes you may want to keep.

Click [OK].

Trimmed clips are placed in the Working area.

To save the edited project as a single video file, refer to P122.
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Multiple Trimming Screen

Video display

The selected video is played back.

Elapsed time

Shows the current playback position. 

Playback slider 

Drag to change the playback position.

IN-point slider

When trimming video, drag to set the start point of the video you want to keep.

OUT-point slider

When trimming video, drag to set the end point of the video you want to keep.

List

Displays the start and end time of the trimmed range.

[Delete] button

Deletes the trimming range selected in the List.
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Playback button

Plays back/pauses video. During playback, the button will appear as Pause but-
ton. 

Skip to previous button

Jumps to the previous trimming point. If there is no trimming point, jumps to the 
beginning of the video file.

Skip to next button

Jumps to the next trimming point. If there is no trimming point, jumps to the end 
of the video file.

Cut button

Cuts the trimming range determined by the current location of the IN and OUT 
points.

Mute button

Mutes/restores the volume.

Volume level

Adjusts the volume of the video you are playing.

[OK] button

Adds the trimmed scenes that appear on the List to the Working area.

[Cancel] button

Returns to the movie editing screen without setting any trimming ranges.
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Adding Scene Transition Effects (Transition)
You can add a transition effect between scenes. A transition bridges two 
contiguous scenes, adding a visual effect at the point where the first scene 
changes to the next scene. 

This operation can be performed both in Timeline and Storyboard view.

Click [Transition].

Select the clip you want to open with a transition.
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Select a transition type.

By selecting a transition and clicking [Preview], you can see how the scenes switch.

Enter the desired transition time.
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Click [Apply].

Click [ ] to check the result.

To save the edited project as a single video file, refer to P122.

Handling clips with transitions

Transition will be canceled if you move clips with a transition, or insert another 
clip between the two clips with a transition. When trimming a clip with a transition, 
remove the transition before trimming.

To change applied transitions

Select the second  clip (the clip that opens with the transition you want to change).
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Transition panel

Transition list

Select a transition type.

Transition start point

Displays the start point of the transition.

Transition end point

Displays the end point of the transition.

Transition time bar

Drag to change the start/end point of the transition. The transition time will 
change accordingly.

Transition time

Enter the transition time.

[Apply] button

Applies the selected transition.

[Preview] button

Displays the result on the Video display.

₁

₂

₃

₄

₅

₆

₇



Chapter 7  Editing Videos

106

Adding Text (Titler)
You can add text at any point of the video. Titler can be used for displaying on 
the video the title, recording date or comment of the video file.

This operation is performed in Timeline view only.

Click [Titler].

The Working area changes to Timeline view if you are working in Storyboard view. 
Click [Library] to return to the Storyboard view.

Drag the slider to the point where you wish to display text.

※
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Select a titler type.

Enter text.

You can enter up to 64 characters. By selecting a titler type and clicking [Preview], 
you can see how the text moves.

Insert line breaks if the text is too long to display.  
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Change the text settings.

 Set font, text size, color and display time.

Click [Apply].
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Click [ ] to check the result.

To save the edited project as a single video file, refer to P122.

⒎

て



Chapter 7  Editing Videos

110

Titler panel

Titler list

Select how the text will appear and move.

Text box

Enter the text to display on the video.

Font menu

Select the font for the text.

Text size

Enter the text size.

Color palette

Select the text color.

[Stop at stop position] check box / Stop time

Check the box if you wish to stop the text after being displayed for a certain 
time. When you check the box, enter the time after which you want to stop the 
text between 0.5 second and the total display time.

Display time

Enter the display time (0.5 - 10 seconds).
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Text style

Set text style (bold, italic, underline, strike-through).

Alignment

Set text alignment (left, center, right).

Text direction

Set text direction (vertical, horizontal).

[Apply] button

Applies the text settings.

[Preview] button

Displays the result on the Video display.
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Adding Music (Background music)
This operation is performed in Timeline view only.

Click [Audio file].

The Working area changes to Timeline view if you are working in Storyboard view. 
Click [Library] to return to the Storyboard view.

Add music file(s).

Select a folder in the upper half of the panel and drag & drop a music file from the 
lower half of the panel to the Working area.

Usable music clips

You can use the “.wav” or “.mp3” files. 
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Click [ ] to check the result.

You can change the start point of the music by dragging the music clip to the right or left.

To save the edited project as a single video file, refer to P122.
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Adding Audio to the Scenes (Audio Dubbing)
You can add narration and music to imported videos using an external device. 
(audio dubbing)

To connect audio devices such as a microphone, see the instructions for the device.

This operation is performed in Timeline view only.

Click [Audio].

The Working area changes to Timeline view if you are working in Storyboard view. 
Click [Library] to return to the Storyboard view.

Drag the slider to the point where you wish to add audio.

※
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Start recording.

Click [ ].

Click [Yes] in the dialog box displayed.

Select the save destination for the recorded audio.

Click [Save].

Recording will start.

Stop recording.

Click [ ].

The recorded audio clip will be placed on the Working area.
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Click [ ] to check the result.

To save the edited project as a single video file, refer to P122.

Audio panel

Record button

Starts recording.

Stop button

Stops recording.

Recording level slider

Select the volume of the recorded audio.
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Adjusting the Volume (Fade-in/Fade-out)
You can adjust the volume of the imported video clip. You can also use sound 
effects to make the volume become louder gradually (Fade-in) or softer gradu-
ally (Fade-out).

To adjust the volume of the audio included in the video, you can use Timeline and Storyboard 
view. To adjust the volume of the added audio (background music), use Timeline view.

Click [Adjust Volume].

Select the video clip whose volume you wish to adjust.
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Adjust the volume.

Adjust the volume with the vertical slider.

Adjust the Fade-in / Fade-out duration.

Adjust with the horizontal slider.
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Click [Apply].

Click [ ] to check the result.

To save the edited project as a single video file, refer to P122.
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Adjust Volume panel

Volume slider

Adjusts the volume of the video file. The green area shows the volume.

Fade-in slider

Allows you to set the sound so it becomes louder gradually (Fade-in).

Fade-out slider

Allows you to set the sound so it becomes softer gradually (Fade-out).

[Apply] button

Applies the volume settings.

[Preview] button

The setting result is played back.
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Saving Edited Contents
By saving a project, you can stop editing at any point and resume editing lat-
er. By saving a project before exporting, it is easier for you to check the actual 
results and re-edit the project if necessary.

Select [Save project] from the [File] menu.

Select the save destination and click [Save].

The project is saved.
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Saving the Edited Result as a Single Video File

Saving the Edited Video

Click the [Save] tab.

The save settings screen will be displayed.

Click [Save].

The save dialog box will be displayed.
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Select the save destination and click [Save].

The edited project is exported as a single file.
 

The edited videos

When you add an edited video file to the Library, [Video bitrate] information does 
not appear in the File Information Panel.
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Storing Videos
This chapter explains how to write videos on a disc and write back videos to the 
camcorder.
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Writing Videos on a Disc (Disc Creation)

Writable Discs and Playable Devices
"ImageMixer 3" can create discs in four different ways (Writing Lists). Writable 
discs and playable devices vary according to the Writing List that you 
selected. Select the Writing List according to your purpose.

DVD List AVCHD List Blu-ray List DataDisc List

Purpose

Store standard 
definition video that 
was converted from 
high definition video  
※ 1

Store high definition 
video as is  ※ 2

Store high definition 
video as is

Store high definition 
video as is

Writable Discs
DVD-R
DVD-R DL
DVD-RW

DVD-R
DVD-R DL
DVD-RW

BD-R
BD-R DL
BD-RE
BD-RE DL

DVD-R
DVD-R DL
DVD-RW

Playback on  
"ImageMixer 3 
SE Player"

- OK OK OK

Playback on  
a standalone 
DVD player

OK OK - -

Playback on  
a standalone BD 
player

OK OK OK -

※     Writing on 8 cm disc is not supported.

※     Make sure that your DVD or BD player supports the disc type that you are going to play back.

※ 1  Due to the conversion, it may take time to create a disc with DVD List.

※ 2 When creating a disc from an AVCHD List with video recorded in MXP mode, the quality of the videos are  
        converted to FXP mode quality. Also, it may take time to create a disc due to the conversion.
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Writing Videos in the Camcorder onto a Disc
When you use a DVD disc, you can save videos directly from the camcorder.

When writing on a BD disc, follow the instructions on P131.

Turn on the camcorder and set it to the movie playback mode.

Connect the camcorder to the computer.

Refer to P30 for how to connect the camcorder to the computer.

The [ImageMixer 3 Launcher] screen appears on the computer.

When connecting the camcorder

Note the following instructions when connecting the camcorder:

Use the compact power adapter to power the camcorder.

Connect the camcorder and the computer directly with a USB cable. Operation us-
ing USB hubs is not guaranteed.

Do not put the computer in Standby mode when a camcorder is connected.

Click [Create Disc] on the [ImageMixer 3 Launcher] screen.

A confirmation dialog box will be displayed.
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Select the standard of the disc you want to create and click [OK].

The disc creation screen will be displayed.  

When creating a disc in DVD-Video standard

Note the following;

The picture quality will be degraded because the original high definition video 
content is converted to standard definition. 

Due to the conversion, it may take time to create a disc.

Select the videos to include on the disc.

Click [ ] (select videos that have not been saved yet) or [ ] (select all) or se-
lect individual videos you wish to save.
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Insert a disc and click [Write].

A confirmation dialog box will be displayed.

Select the writing options and click [Create].

Writing drive

 Select the writing drive.

Eject button

Opens the disc tray. Select the writing drive and insert a disc.
A message whether the inserted disc can be used for writing or not appears at the bottom.
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Number of discs

Displays the number of discs required for writing.

When multiple discs are required

If the videos cannot be written on one disc, they are divided into multiple discs. When 
the previous disc is finished, replace with a new disc and click [Create].
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Disc creation screen

Source pane

The camcorder connected to the computer is displayed. 　

Browser pane 

A list of the video files in the camcorder selected from the Source pane is displayed.

Select difference button

Selects videos in the camcorder which have not yet been imported to the computer.

Select all button

Selects all videos on the Browser pane.

Cancel selection button

Cancels all video selections in the Browser pane.

Capacity bar

Displays the total size of the selected video files and the disc capacity. If the to-
tal size exceeds the disc capacity, the value will be shown in red.

Number of titles

The number of titles selected is displayed.

[Write] button

Starts writing.
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Writing Videos in the Library onto a Disc
You can select videos in the Library and write onto various types of disc ac-
cording to your purpose.

Click [Browsing & Authoring] on the [ImageMixer 3 Launcher] screen.

The Library screen will be displayed.  

Click [Library].
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Create a list to write on a disc.

Click [Disc List].

Select the list type to create.
[New DVD List]: Creates a DVD disc in DVD-Video standard.
[New AVCHD List]: Creates a DVD disc in AVCHD standard.
[New Blu-ray List]: Creates a Blu-ray disc.
[New DataDisc List]: Creates a DVD disc exclusively for “ImageMixer 3”.

Disc type and playable devices vary according to the list type. Refer to P125 for details.

When creating a disc from the DVD list

Note the following;
The picture quality will be degraded because the original high definition video 
content is converted to standard definition. 
Due to the conversion, it may take time to create a disc.

Use of the DataDisc List

When you use the DataDisc List, you can store  videos to a disc without degrading 
picture quality. For example, if you don't have Blu-ray disc drive, you can store videos 
recorded in MXP mode (a recording mode) to a DVD disc without degrading picture 
quality. The maximum recording time is the capacity of the DVD disc. The disc 
created from the DataDisc List can only be used in "ImageMixer 3".  

Enter the list name and click [OK].
A new list is created in the Source pane.

The list name

The list name entered in this step becomes the menu title of the created disc (P138). 
Note that the menu title will be [Untitled] if the list name is not entered.

The length of the title which can be displayed in the menu screen is as follows;

DVD List: approximately 20 bytes
AVCHD / Blu-ray / DataDisc List: approximately 30 bytes

Above number is a rough guide. The number changes depending on the characters used.
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Add to the list the videos you wish to include on the disc.

Click [Library].

Drag & drop the selected video file(s) to the list you created in step 3.

You can add up to 99 files.

To select multiple files

To select contiguous files, hold down the [Shift] key and select files, or to select non-
contiguous files, hold down the [Ctrl] key and select files.

If you wish to set the chapter on each video file, refer to P139 starting from step 3 
onwards.

Capacity bar

The estimated size of video files is displayed at the bottom of the Browser pane. Re-
move video files when the value on the capacity bar is shown in red. Use the capacity 
bar display as a reference for the total size of the video files; you may not be able to 
write a disc even if the bar is shown in green.
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Edit title names.

The file names in the Library become the title names in the menu screen of the cre-
ated disc. If you do not need to change the title names (keeping the file names in the 
Library), go to the next step.

Click the list created in step 3.

Select the file to change and click [Information].

Click the [Options] tab and enter the new file name in the [Title] box.

The length of title names

The length of the title which can be displayed in the menu screen is as follows;

DVD List: approximately 8 bytes

AVCHD / Blu-ray / DataDisc List: approximately 12 bytes
Above number is a rough guide. The number changes depending on the characters used.
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Set the menu screen.

Set the menu screen of the disc.

Right-click the list created in step 3.

Click [Edit (the name of the List that you selected)... ].

The settings screen will be displayed.

Select the menu screen settings and click [OK].

Select menu

Select the design of the menu screen of the disc.

Disc size

Select the disc type to write.

For details about the menu screen, refer to P138.
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Select writing options.

Set a disc to the drive.

The disc to write on varies depending on the Writing List that you selected. Refer to 
P125 for writable discs.  

Click [Write].

The settings screen will be displayed.

Select writing options and click [Create].

Writing will start.

The image below is for illustration purposes only. Some items are not displayed de-
pending on the disc selected for writing.

Writing drive

 Select the writing drive.

Eject button

Opens the disc tray. Select the writing drive and insert a disc.
A message whether the inserted disc can be used for writing or not appears at the bottom.
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Disc Erase

If you set a DVD-RW disc that already contains data, you need to select the 
erasing method. 

Quick Erase 
Erases quickly. An error may occur depending on the content to erase; however, under normal cir-
cumstances, the content can be erased with this method.

Complete Erase
This may take more than 60 minutes, but ensures few possibilities of errors. Select this method 
if, for example, you encountered an erasing failure with Quick Erase.

Write after testing

Executes a test writing for DVD-R discs. It may take time, but it may keep you 
from wasting discs due to writing failures.

Check after writing

 After the disc is written, verifies that the data has been written accurately and 
in its entirety.
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Menu screen
The following menu screen will be displayed when you play back a disc created from a 
Writing List in the Library.

Menu title

The name of the DVD/AVCHD list will appear as the menu title of the disc.

Title thumbnail

Displays a thumbnail of the video.

Title name

The name of the title.

Page number

Displays the number of the current menu screen out of the total number of menu 
screens.

Turn a page

Turns a page when there are multiple menu screens.
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Setting Chapters in a Video File
"Chapter" refers to a break in the video file. When you skip scenes during the 
playback of a video, scenes jump from chapter to chapter. By setting your fa-
vorite scene as a chapter, you can display the scene quickly. Chapters can be 
set in video files added to the Writing List.

Click [Browsing & Authoring] on the [ImageMixer 3 Launcher] screen.

The Library screen will be displayed.  

Create a list to write on a disc.

For details about the list to create a disc, refer to P131.
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Open the chapter settings screen

Click the Writing List containing the video file for which you wish to set chapters.

When the same file is registered in multiple Lists, chapter settings apply to that file 
in all the Lists. If you wish to set chapters separately, import the same file from the 
camcorder again.

Select the video file to set chapters.

Select [Set Chapters] from the [Edit] menu. 

The chapter settings screen will be displayed.

Display the scene where you want to set a chapter.

Display the scene with [ ]/[ ]/[ ] or the playback slider.
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Click [ ].

When setting two or more chapters, leave an interval of more than 3 seconds be-
tween chapters.

Chapters cannot be set if the interval is less than 3 seconds.

The chapter setting is added to the chapter list.

Repeat steps 4 and 5 to set additional chapters as necessary.

You can set up to 20 chapters for one video file.

Click [OK].

Chapters will be applied.
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Chapter settings screen

Video display

The selected video is played back.

Chapter list

Active chapters are displayed. You can set up to 20 chapters for one video file.

[Delete] button

Cancels the chapter setting selected in the chapter list.

Elapsed time

Shows the current playback position. 

Playback slider

Shows the current playback position. You can also drag the slider to set where 
to start playing.

Remaining time / Total time

Displays the remaining time of the video during playback. Clicking this area 
switches the display between total and remaining playback time. 
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Playback button

Plays back/pauses video. During playback, the button will appear as Pause but-
ton. 

Chapter setting button

Sets a chapter at the scene currently displayed.

Mute button

Mutes/restores the volume.

Volume level

Adjusts the volume of the video you are playing.

[OK] button

Applies the new chapters.

[Cancel] button

Returns to the Library without applying chapters.
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Writing Back to the Camcorder

Before Writing Back
You cannot write back videos that were recorded in a video format or video system 
different from that of the camcorder.  It may cause the camcorder to malfunction.

If the camcorder is disconnected from the computer while writing back, video files 
in the camcorder may be damaged. Use the compact power adapter to power the 
camcorder. Make sure that the USB cable is correctly connected to the computer. 

You cannot write back when using a camcorder other than the Canon camcord-
er with which "ImageMixer 3" is bundled.

For writing back videos, free space of at least twice the volume of data to be 
written is required.

If writing back all the selected videos would exceed the maximum number of 
scenes of the camcorder, as many videos as possible will be added until the 
maximum number of scenes is reached.

The maximum number of scenes stored in the camcorder differs depending on the model.

You can write back up to 100 scenes at one time.

You cannot write back to the SD Memory Cards that do not support the SD 
Speed Class.

If the Speed Class of the SD Memory Card being used is different from that of 
the Memory Card used for recording, the video size and other elements may be 
altered after writing back. 

Do not use a computer or other device to initialize the camcorder. Always use 
the camcorder for initializing.

It is recommended to use the SD Memory Card of identical manufacturer and 
model number when you write back the video which is recorded to the SD Mem-
ory Card capacity and saved on the computer. Initialize the SD Memory Card 
completely using the camcorder before writing back.

Note that the videos recorded to the maximum capacity may not be written back to the 
camcorder due to the volume calculation.

Initialize the camcorder's built-in memory (or hard disk) completely before you 
write back the video which were recorded to the built-in memory (or hard disk) 
capacity and saved on the computer.

Note that the videos recorded to the maximum capacity may not be written back to the 
camcorder due to the volume calculation.

For the sake of protecting your recordings, it is recommended to save all the 
videos in the camcorder onto the computer before writing back to the camcorder.
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Writing Back to the Camcorder 

Click [Write Back to Camcorder] on the [ImageMixer 3 Launcher] 
screen.

The write back screen will be displayed.  

Select the destination to write back.

Select the camcorder or the SD Memory Card inserted in the camcorder.

Make sure that the SD Memory Card is not protected against writing.
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Select the video files or Album to write back.

Videos that can be written back

You can write back the following videos as long as they have the same video format 
and video system as the camcorder.

Videos originally saved on the computer from the camcorder with which "ImageMix-
er 3" is bundled.

Such videos after they have been edited with "ImageMixer 3".

For creating an Album/Smart Album, refer to P65, P67.

Click [Write Back].

A confirmation dialog box will be displayed.

⒊
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Click [OK].

Writing back to the camcorder starts.
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Write back screen

Source pane

Displays the Library, Albums, and Smart Albums.

Write back destination 

The camcorder connected to the computer and the SD Memory Card inserted in 
the camcorder are displayed.

Browser pane 

Displays the list of video files in the Library, Albums, and Smart Albums selected 
from the Source pane.

Capacity bar

Displays the free space in the write back destination and the total size of the 
selected video files. When the size of the selected video files exceeds the ca-
pacity, the value is displayed in red. The number of “selected files / total files” is 
displayed on the right side of the bar.

[Write Back] button

Starts writing back to the camcorder.
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Troubleshooting
This chapter explains frequently asked questions about "ImageMixer 3" and in-
cludes User Support Centers in your region.
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Frequently Asked Questions

Preparation

I can't install "ImageMixer 3".

"ImageMixer 3" can be installed in computers with following operating systems:

Windows XP Service Pack 2

Windows XP Service Pack 3

Windows Vista

Windows Vista Service Pack 1

What's the certification code?

During the installation procedure, the certification of the software is performed 
through the Internet. For those who do not have an Internet connection, it is re-
quired to complete the certification manually (enter certification code).

Where can I acquire the certification code?

To acquire the certification code, call our User Support Center in your region 
(P159).

I can't start "ImageMixer 3".

To install and use "ImageMixer 3", you must be authorized as an Administrator.

I can't use the standard disc drive pre-installed with the comput-
er after installing "ImageMixer 3".

This problem may be solved by updating any disc authoring software already in-
stalled in the computer.

"ImageMixer 3" does not work properly.

Exit "ImageMixer 3" and restart the computer.
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My camcorder is not recognized by the computer.

Check the following:

Have you installed "ImageMixer 3"?

Have you turned on the camcorder?

Is the camcorder powered using the compact power adapter?

Is the USB cable connected to the computer properly? 
If the USB cable is connected properly and is not recognized, connect to another USB 
port of the computer.

Disconnect the USB cable, then restart the computer and reconnect the cam-
corder with the computer following the correct procedure.

Disconnect any USB devices other than the camcorder, keyboard, and mouse.

If the camcorder is connected via a USB hub, connect the camcorder directly to 
the computer.

If resident software are installed, exit them and connect the camcorder again.

Some items cannot be selected in “ImageMixer Launcher”screen.

You cannot select the [Create Disc], [Save Files to PC], and [Write Back to 
Camcorder] buttons unless you connect the camcorder to the computer. 
Connect the camcorder to the computer to use there functions (P30). 

The [Reading information…] dialog is displayed and the reading 
takes time.

The [Reading information…] dialog is displayed when file information in the 
camcorder is read. It may take time to read when there are many files in the 
camcorder. When you don't use the files in the camcorder, for example, using 
the files which have already been imported, you can skip reading by clicking the 
[Cancel] button. 
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Saving on the Computer

I can't transfer videos from the camcorder to the computer.

Try another USB port of the computer. For desktop computers, try the USB port 
on the back.

It takes a long time to import video from the camcorder to the 
computer.

It takes a long time when importing many files in one batch or importing a large 
video file.

When importing, close all software other than "ImageMixer 3".

Processing speed may vary depending on your computer's configuration (for ex-
ample, CPU performance and RAM), or on the content of the video.

The message “Data is too large to write to.” is displayed.

Decrease the total volume of the files to write on a disc. The capacity of the disc 
varies depending on the disc type. Also, note that you may not be able to write 
on a disc if the total volume of the files is close to the disc capacity.

DVD-R, DVD-RW: 4.7 GB

DVD-R DL: 8.5 GB

BD-R, BD-RE: 25 GB

BD-R DL, BD-RE DL: 50 GB

The message “Not enough disk space for the workspace.” is displayed.

For creating a disc, free space at least twice the volume of date to be written on 
the disc is required in the workspace. Increase the free space in the workspace, 
or change the workspace in the Preference screen (P58).

It takes time to import videos.

If resident software are installed, exit them before importing.
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Playing Back Videos

I want to change the screen size.

Select the screen size from the [View] menu, or drag the edge of the window.

The video in the camcorder is not played back smoothly.

Depending on the content, the video may not be played back smoothly because 
of USB transfer rate limitations. It is recommended to add these videos to the 
Library and play them back from there.

Videos may not be played back smoothly depending on your computer's configu-
ration, for example CPU performance and memory capacity, or on the content of 
the video.

I can't play back video with "ImageMixer 3 SE Player".

"ImageMixer 3 SE Player" can play back the following videos: 

H.264 files

Discs created from the "AVCHD List" in "ImageMixer 3".

Discs created from the "Blu-ray List" in "ImageMixer 3".

Discs created from the "DataDisc List" in "ImageMixer 3".

Videos may not be played back properly if a playback freeware or codec is in-
stalled.

The joining points between chapters are not played back smoothly

When playing back the disc created with "ImageMixer 3", the joining points 
between chapters may not be played back smoothly. In Movie Edit, place clips 
on the Working area in a row, export them as one video file, then save the file on 
a disc. Playback will now be smooth. Note that the exported file created in the 
Movie Edit is a different file. It is recommended not to delete the files used for 
exporting and keep the files as they are.
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Importing and Organizing Videos (Library)

(Cannot find this file) appears.

"ImageMixer 3" cannot find files if, for example, the files are deleted in Windows 
Explorer after being added to the Library. Do not delete or move the video files 
you use in "ImageMixer 3". If you are using removable media such as a USB mem-
ory, save the video files to the computer in advance, before adding them to the 
Library.

I want to erase all (Imported mark).

Select [Preferences...] from the [Settings] menu and reset.

I can't arrange the order of the videos in a Smart Album.

In Smart Albums, files cannot be sorted by drag & drop.

I want to close the File Information panel.

Click [Information] again to close the File Information panel.

I can't transfer the file exported for iTunes to my iPod.

iTunes is required to transfer files to the iPod. You can download iTunes from the 
Web site of Apple Inc. Use iTunes to transfer the exported file to your iPod.
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Editing Videos

It takes a long time to save videos edited with "ImageMixer 3".

It takes a long time if the video format (video system/resolution) of the project 
setting differs from that of the original file. 

Processing speed may vary depending on your computer's configuration (for ex-
ample, CPU performance and RAM), or on the content of the video.

The edit video size becomes larger than the original.

If re-encoding is applied to the edited contents, the file size may become larger 
than that of the original.

Is the picture quality after editing changed from the original?

The picture quality in the edited parts may become lower than the original due to 
re-encoding. The parts which are not edited retain the original picture quality. 
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Storing Videos

Drives are not detected.

Drives may not be detected if the computer is not restarted after installing "Im-
ageMixer 3".

Drives may not be detected if writing software (packet writing) is already in-
stalled.

I can't add a file to the Writing List.

In the following cases, you cannot add files to the Writing List.

The Writing List contains 99 files already.

The video system of the file you are going to add is different from those that has 
already been added to the list.

It takes a long time to write a disc.

Processing speed may vary depending on your computer's configuration (for ex-
ample, CPU performance and RAM), or on the content of the video.

I can't write on 8 cm disc.

Writing on 8 cm disc is not supported.

I can't write on a disc.

Is the disc supported by "ImageMixer 3"? (P125) 

Does the writing drive support the disc?  Check the disc types supported by your 
computer's drive.

Is there sufficient free space in the computer's working hard disk?  Free space of 
at least twice the volume of data to be written is required for creating a disc. 

Check if the total size of the video file exceeds the disc capacity. Remove some 
video files to meet the disc capacity.
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Disc writing fails when using a rewritable disc after erasing the 
recorded data.

Disc creation may fail if the data on a rewritable disc has been erased using 
software other than "ImageMixer 3". When using a rewritable disc which has al-
ready been recorded, insert the disc as it is and erase the recorded data using 
the writing options of "ImageMixer 3".（P137)

I want to change the menu title and the names of titles on the disc.

You should enter the menu title and title names before writing a disc. 

Changing menu title: 
The name of the list which you created for writing a disc will be the menu title.

Changing title names: 
Select the file whose name you want to change in the Library and click [Information], then 
open the [Options] tab. Enter a name in the [Title] text box to change the title name.

Menu title and title names are not fully displayed.

The number of characters which can be displayed in the menu screen is limited.

Menu title

DVD List : approximately 20 bytes 

AVCHD / Blu-ray / DataDisc List : approximately 30 bytes

Title name

DVD List : approximately 8 bytes 

AVCHD / Blu-ray / DataDisc List : approximately 12 bytes

The number changes depending on the characters used.

I can't write back to the camcorder.

You can write back the following videos as long as they have the same video 
format and video system as the camcorder.

Videos originally saved on the computer from the camcorder with which "ImageMixer 
3" is bundled.

Such videos after they have been edited with "ImageMixer 3".
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Others

I can't exit "ImageMixer 3".

Close all dialog boxes and setting screens before exiting.

File extensions are not displayed.

Follow the steps below to show file extensions.

Windows XP

Open any folder.

Click [Tool] menu - [Folder Options] - [View] tab.

Uncheck [Hide extension for known file types].

Windows Vista

Open any folder.

Click [Organize] - [Folder and Search Options] - [View] tab.

Uncheck [Hide extension for known file types].
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ImageMixer 3 Support Information 
PIXELA CORPORATION offers a support service for registered users. For technical 
inquiries about this product, please contact our User Support Center in your region.

PIXELA CORPORATION User Support Centers

USA and Canada

+1-800-458-4029 (toll-free)

Language: English

Europe (UK, Germany, France, and Spain)

+800-1532-4865 (toll-free)

Language: English, German, French, Spanish

Other Countries in Europe

+44-1489-564-764

Language: English, German, French, Spanish, Italian, Dutch

Asia (Philippines)

+63-2-438-0090

Language: English

China

+86-21-5385-3786

Language: Chinese
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Homepage
Please check our Web site for latest information and downloads. 

http://www.pixela.co.jp/oem/canon/e/
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